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1. Qué es Mendeley?

Mendeley es un gestor de referencias bibliograficas que combina una versiéon web con una
version de Escritorio o versidn local. Permite importar, organizar y trabajar con referencias
bibliograficas, asi como generar bibliografias en muchos estilos. Una parte importante de
Mendeley son sus funcionalidades de web social, que permiten la conexién entre
investigadores, comentarios y anotaciones compartidas sobre documentos en formato pdfy la
promocién de los trabajos propios. Ademas, Mendeley es una importante fuente de
informacidn bibliografica, ya que es posible hacer busquedas sobre el conjunto de los
documentos que tienen los usuarios en sus propias bibliografias.

2. Mendeley Institutional Edition (MIE) en el CSIC

El CSIC, a través de |la Red de Bibliotecas y Archivos, pone a disposicidon de todo su personal la
version institucional del gestor de referencias bibliograficas Mendeley (Mendeley Institutional
Edition, MIE) con ventajas sustanciales respecto a la version gratuita.

Funcionalidad Version gratuita | MIE
Almacenamiento 2GB 5GB

N2 de Grupos de trabajo privados 1 1000
Usuarios por grupo 3 25
Almacenamiento en grupos de trabajo 100 MB 20 GB
Meétricas de impacto de publicaciones propias No Si
Recomendaciones de articulos a partir de su biblioteca | No Si

personal con Mendeley Suggest

Acceso a los textos completos de documentos existentes | Configuracién Configuracion
en Mendeley que se encuentren en revistas suscritas por | manual por defecto
el CSIC a través del Servicio de Enlaces CSIC, con la

posibilidad de obtener acceso off-campus mediante el

servicio PAPI

2.1.Cémo formar parte del grupo MIE del CSIC y disfrutar de sus ventajas

Si ya tiene creada una cuenta gratuita en Mendeley, puede actualizarla y unirse al Grupo
Institucional del CSIC entrando en esta URL:

https://www.mendeley.com/groups/7006121/consejo-superior-de-investigaciones-
cientificas-csic/?broadcast=1

Una vez situado en esta pagina, pulse el botén “Join this group”.

€A h del 0062 1c perior-d fones-cientficas-csicf?broadeast=1 e buscar + A B A4 = -

(] science Magazine (] Més visitados . Gestién de PAPL - Mod... (@) Comenzar a usar Firef... (5] (itimas noticias B Red de Bibliotecas y 4... £ Personalizar vinculos {_| Save to Mendeley

AR MENDELEY

GetMendeley ~ WhatisMendeley?  Papers = Groups Groups

csic Consejo Superior de Investigaciones Cientificas (CSIC)
Inthis aroup: 4 members
v B
@ Overview
Recent publications About this 1 on

Members

ooy

De aca nara alla: Facilitando la navenacion entre recursos
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En la ventana emergente, pulse OK para verificar que el correo que aparece en su cuenta, es el
institucional del Consejo Superior de Investigaciones Cientificas.

Si usted no esta registrado en Mendeley con su correo institucional del CSIC, en el momento
de pedir su adscripcion al grupo CSIC tendrd que proporcionar a Mendeley un correo
institucional para que el sistema le permita unirse al grupo. Si lo desea puede cambiar su
correo en la cuenta de Mendeley yendo a "Account Details”>“Personal Details".

En caso de que aun no tenga creada una cuenta en Mendeley, debe crearla antes para poder
unirse al grupo CSIC (ver apartado 3 “Creacidn de una cuenta gratuita en Mendeley).

Para comprobar si se esta en la cuenta institucional, ir a “My Account”>“Account details”.

€ | @ fitpsfiwws, mendeley, com/accountidetals | e Buscar

{1 science Magazine (8] Mas vistados |, Gestién de PAPI - Mod... (@) Comenzar a usar Firef.. (5] Ultimas noticias [ Red de Bibliotecas v A... &7 Personalizar vinculos

M EN ELE Welcome back Inmaculada Ramos
Get Mendeley =~ Dashboard = MyLibrary ~ Papers  Groups = People Papers =
My Account
Account Details || Persanal Details || Privacy || Notifications || Sharing/imparting || Billing Details

Accounts

a

® Mendeley Institutional Edition (Team) plan

T 5068 perzonal library space, 1000 groups, 25 collaborators, 20.0 GB graup library space

2 Contact us 1o cancel plan

=
Personal Space

L) 2MB /5 GH Personal Space

Shared Space

3. Creacidn de una cuenta gratuita en Mendeley

]

+ & wE 4

{7} Save to Mendeley

[UZETIA Install Mendeley Desktop

wiete niring! / Support

2(- 6 P

Q

Acceder a la pagina web de Mendeley: http://www.mendeley.com/

Pulsar el enlace “Create a free account”

CSIC) y Contrasena.

Introducir nombre y apellidos, Correo electrénico (mejor el correo institucional del

Al reconocer el correo institucional del CSIC, Mendeley ofrece de forma automatica la

posibilidad de unirse al grupo institucional del CSIC y de esta forma poder tener las
ventajas de Mendeley Institutional Edition. El usuario debe confirmar que quiere

unirse al grupo.
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{"] Science Magazine (] Més visitados .. Gestién de PAPI-Mod... (@) Comenzar a usar Firef... (5| Ultimas noticias B0 Red de Bibliotecas y A... &7 Personalizar vinculos { | Save to Mendeley

A MENDELEY

Your research, anywhere.

For students and researche e iy on cl|Qs ‘B 429
Soence Magaane (B Mis istads . GestindePP1-Mod.. @) Conenaa avsarFref. ) timas noticas [ Red de Bboteces y A.. Y Pesonaiarvindos | Saveto Nendey

Mendeley is a free reference man:
network. Make your own fully-sea M MENDELEY

you write, and read and annotate

Create a free account Ay o Mondel Sin
Create a free account

adforrecon @ 5@ O io!

2y

-
g
H
g
1
a
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4. Version escritorio o version local (Mendeley Desktop)

En primer lugar, descargar la aplicacidon para instalar en nuestro ordenador, desde el botdn
“Download Mendeley Desktop”. Para otras versiones, ir a “Need a different version?” y elegir
la correspondiente al sistema operativo (Mac, Windows y Linux), también incluye una version
para Iphone, Ipad e Ipad Touch.

¢a endel e ][ ausear ¥ A A 4 -0 0 B =

{ ] Science Magazine: (2] Més visitados || Gestion de PAPI - Mod .. (@) Comenzar a usar Firef . (5] (lltimas noticiss [ Red de Bibliotecas y & &7 Personalizar vinculos { | Save ko Mendeley

AR MENDELEY

GetMendeley | Dashboard = MyLibrary Papers = Groups = People Fapers Q

# Download Mendeley Desktop

or Windows XP or later

INeed a different version'

Welcome back Inmaculada Ramos v 2 My Account =

We'te hiring! / Support

Noeqpaa4 g

How to install Mendeley

1. Download Mendeley Desktop 2. Install Mendeley Desktop 3. Open Mendeley Desktop
@ Downloads E=s(Eey =) OpenFile - Security Warning == =5 o =5
Do you wer o s e?
Mendeley-Deskto
o — e

23.2 MB — mendeley.com B

Clearlist | Search. p an == MendeleDesktop
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Welcame hack Inmaculada Ramas ? My Account T

JA MENDELEY

GetMendeley =~ Dashboard  MyLibrary Papers Groups People Papers ~ | Search. Q

‘We're hiring! / Support

Download Mendeley Desktop for Windows

Save time managing PDFs, instantly share thoughts on papers with colleagues and Mendeley Desktop for other systems

automatically back Lp and sync your files between different computers
e
i‘ Mendeley Desktop for Mac 0S X 10.6+

A Mendeley Desktop for Linux

Download Mendeley Deskto
ey Mendeleyfor iPhone, iPod Touch and iPad
a0 A Opensinthe iTunes App Store 5]

Latestversion farWindows XP of later  See release notes

=
=
b1
g
2

Current Development Preview

I Let research fall into place Explore new features currently in development and provide
4&7 Automatically collate, rganise and manage your PDFs using folders, tags, fillers us with feedback: dowmioad the current development
and full text search. More preview:

La pantalla de la version escritorio se estructura en tres columnas

= Columna de la izquierda: “My Library”, donde podemos organizar y administrar
nuestros documentos. Podemos ir a un grupo al que pertenezcamos. También
podemos aplicar filtros.

=  Columna central: Se muestran los documentos de nuestra biblioteca, con dos
formatos de visualizacidn, como tabla (figura de abajo) o como cita, segln el estilo
de cita elegido.

®  Columna de la derecha: donde se visualizan los detalles del documento
seleccionado, también se puede completar la informacidn agregando etiquetas y
notas.

% Mendeley Deskiop
File  Edit WUEMN Tools  Help

Library as Table: b
- b Q-
Library as Cikations

L4
Ak Flles nc Search
| Citation Styls >
Menderey Tookbar Layaut * Al Documents | Edi Settings
J Liter| v show Document Detals At +Rlurn
wr @ B Athors Tile vear Published In Added Rl | Noles | COMents | Enncmerts
My Library o  BagueroAmbas, Mercedes  La evaluacion dela coleccién de la bibliteca, un bien may 11 —
) Al Documents necesario en tempos de crisis Ty [Working Faper T/
2 Eshkar-Oren, L; Krief, 5.; ... Vascular patterning regulates interdighal cel death by a 2015 Development b 14 Consejo Superior de Investigaciones
Recently Added b=t ROS-mediated mechanism OnSelo Sup: 9
Favort N Cientificas - Proyecto Mendeley
W Favorkes * Fernandez-Garcia, Jesus  Mendeley. Guia de Uiizacisn 2015 2:21pm
2. My Publications iuthors:
pr— o GARATE, ARAMOS,T; M. CADMIUM UPTAKE AND DISTRIBUTIGN IN 3 CLITIVARS 1953 BULLETINOF  abr 14
= CF LACTUCA 5P ENVIRONMENT #A View research catalog eniry for this paper
Create Folder... o @ Remos, Inmaculads; Esteb... Cadmium uptske and subcelllar distribution in plarts of 2002 PlantScence  abr 14
ol Lactuca sp. Cd-Mn interaction Wear:
Groups &~ Ramos, Irmaculada; Mont... Suministra electrérico de documentos via Internet 1998 ElProfesionalde  abr 10 Pages:
[ Mendeley Fraject - Spain U la Informacién
Crests Group... o s de Investigaciones Clentficas - Proecto may 14 Abstract:
9 . (Guia de Referencia Rapida - Como utiizar Mendeley end 2013 may 11
pasos )
Fileer by Authors | Tags:
il Consejo Superiar de Investigaciones Clentificas
[Baquera Arribas, Mercedes
eliott, 5. 1. Author Keywords:
Eshkar-Oren, L.
Estehan, Elvira
IFernandez-Garcia, Jesus
Ferrara, N. City:
GARATE, A
Garate, Agustin
ref, 5.
LUCENA, 11 Institution:
Lucena, Juan José
MANZANARES, M
Montes, Angel
RAMOS, © Number:
Ramos, Inmaculada
Zelzer, E.
Series:
o] 1] 1 of & documents selected

5. Importar / Exportar referencias
5.1.Importar referencias manualmente

En el menu principal pinchar en “File” y después “Add Entry Manually”. También desde la
barra de herramientas pinchando en el desplegable “Add Files”. Aparecera un formulario
donde seleccionaremos el tipo de documento y rellenaremos los distintos campos del nuevo
documento.

http:/fbibliotecas. csic.es
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(Nota: Se podra personalizar y afiadir otros campos desde: “Tools”>"Options”>" Document
Details”).

A Mendeley Desktop.
Edt View Took Help
Add Files... Ctri+o
Add Folder, Ctrk+Shift+0

* 0 0wty ) e bk Adtes Deals | izs | Contwts
Inport. . v p— o s dubis Meeds Lsevduso el ccotn s s bkecs, un b eyt
Export... e Fors . L ok
N o B, LS. e patereg gt ek o et by a5 Omekpeent atr
Send by E-mall., By Phestins 1 RS aedted nechrisn
Merge Documents Unserted . FemandezGarca, Jesus  Mendeley. Gula de Utikzacin s mar 18
Create Foider..
: o GAEARANE M. CMUNLPINE MODSTREVTIONINI CATIRS 1950 BWLETNGE  abr
Dileke Dacunients FLTIAT BT
Rames, rmacusdy; Este Cadmn and s.txehdy dstrbuien n of W00 Plak Sdence a4
Remave from Folder ey o span .o - Coble i o b s
Rename Docurent Fles. . Gesean. @ P, Pnscdads; Mok, Suneideo o s docnentos i Fhsnet 1959 Gclescoside e 10
oot
Synchrorias Library F5 Dt . ot e R - Chw i erdekyen s 2019 w1t
s
= Apsesdvones ] Coreep S e netigines entfcs a4 I
Sign Cut {inma.ramos@bib csic.es) o8
Quit e P by hthrs ol

No document

G G ]

Gl (o) (@] 2 &
Trash [P ——

2 Al Deleted Documents s -
i = i
pyes C
|Fier by Authors . e Rolie
et -
Al fratm
Ranarn frvibas Marradac [P .
bsed b
ja o
. -
" g
Y-
i s
- -
- i as I
v 3 |
B Jr— 1w
et
B
e
D Bty R
e
by
- it
iy s
Y
o Jan bt "t
ey =
=t
= .
=

5.2.Importar referencias desde mi ordenador

> Anadir documentos pdf desde nuestro ordenador de forma individual, pinchando en
“Add Files” y seleccionando los documentos a importar. También podremos
seleccionarlos, arrastrarlos hasta nuestra Biblioteca y soltarlos.

Help

Add Folder...
Watch Folder... Search
Add Entry Manualy...
Import N il All Documents Edit Settings
HE ® [ Authors “ Title Year Details Notes Contents Enrichments Ly
° Baquero Arri... La evaluacién de la
coleccién de la biblo..
. -« Eshkar-Ore... Vascular patterning 2015
= requlates interdiglt
o ® Fernandez-.. Mendeley, Guiade 2015
Utilizacién
Synchronize Library FS ° GARATE, A; ... CADMIUM UPTAKE 1993
% AND DISTRIBUTIO...
% 2081 O (et QO ook ) o @ Ramos, Inm.. Cadmiumuptakeand 2002
(2] | Quit Ctri+Q =1 subcellular distributi.
Cesls  CEeGs  dees Gned@) y Create Group... ~ Ramos, Inm... Suministro electrénico 1998
ISEN 2] de documentos via ... H
 Filker by Authors ha | Guia de Referencia 2013
al Rapida - Como utii. [l No documents selected Iy

Baquero Arribas, Mercedes Y Consejo Superior de
Ellott, a. M. Investigaciones Cie...
Eshkar-Oren, 1.

Esteban, Elvira

Fernandez-Garcia, Jesus

Ferrara, N.

GARATE, A

Gérate, Agustin

Krief, 5.

LUCENA, 73

Lucena, Juan José

enlace Ramos, Inmaculada - i
l: F.

/fbibliotecas.csic.as
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Importante: Revisar que los datos se han importado correctamente, corrigiendo los erréneos y
completando los inexistentes, para evitar que los datos volcados en la bibliografia al citar
contengan errores.

» Anadir una carpeta completa, pinchando en “Add Folder” y seleccionando la carpeta con
los pdfs a importar. También se da la posibilidad de importar los documentos contenidos

en las subcarpetas.

S - =]

[d|=] | G = @ - < Q- Search. .
Add Files Folders Related  Share Syne Search
2 g ocuments it Settings
My Library - 2

*

=) ANl Documerts ® [ Authors Title Vear Published In Added Details | Motes Contents Errichments
) Recently Added . a7 Add Folder 2K

)¢ Faworites

2. my Publications ® B ] select the folder you would ke to impart;
[ Unsorted . Mame. a|
Create Folder... B i H
. 3 35d52cc0dda07374bba6g1 14967
Groups () 3500%Ppx

() 43262e1F442054becsh09e24
1) Access

Create Group. .. . O ALsoo

[ Aleph1Temparal

.
=

|E Mendeley Froject - Spain

Trash . () Archivos de programa
& — (L Copia sequridad-Recuperacion
(% Al Deleted Documerts v .m S

Filtes by Authors v =3 Documents and Settings

Al O zusieze No documents selected

Baquera Arribas, Mercedes = So0s768st

Elliott, a. M, = cas

Extar-ren, L ) Kodahiest

steban, Elvira b

Fernandez-Gardia, Jesus (O Apppats

Ferrara, M. () Application Data &

GARATE, A

Garate, Agustin ! Also impart from subfu\be

Krief, 5.

LUCENA, T2

Lucena, Juan José
MANZANARES, M
Mantes, Angel
RAMOS, T

Ramos, Inmaculada
Zelzer, .

|| ]

> Anadir documentos con la opcidon “Watch Folder’: Permite configurar una o varias
carpetas a ser revisadas, importando de forma automatica los documentos pdfs de nueva

incorporacion en las mismas.

Mendeley Deskiop HEE

i | Es = @ 2 [+ Q- search...
Ackd Files Folders Related  Share  Sync Search
= # Options 3]
= = an
My Liby - ———— B — E—
v Library Genersl | Document Detals | FleOrganizer | Watched Folders | BibTex | zoters | Commection
=) All Documents: * jded Details | Notes | Contents | Enrichments
) Recently Added . Tick the Folders you want Mendeley to watch. Any new FOFs in thess Folders will be imported into Hendsley v 11
automatically.
1 Favarites "
8. 1y Publications - Name &
[ unsareed - =0 EC@ 15
35d52cc0dd9027374bbB691149FF
Creats Folder.., . 1) ssommme “
[ 15) 4326221 F442054becabnvesd
Groups
[0 D Access 14
| Mendeley Project - Spain . O 5 aso
Create Group... - [] = alephi8Temporal 10
[ 1) archivos de programa
[ 12 copia sequridad-Recuperacion v 11
. L
Trash a O del
[Z Al Deleted Documents v & [ 53 Documents and Settings b 14
o b N [ 5 24153826p il
Filer by Authors v & 0] & sooe7ssst
Al 06 s i No documents selected
Baquero Arribas, Mercedes 2 oslaext
Ellott, a. M. .
Eshkar-Oren, L. 12 AopData
Esteban, Elvira 1) Application Data
Fernandez-Garcia, Jesus 1) dwhelper
Ei’r’\f\'fé’: g Escritorio
Gérate, Agustin Favoritos
Krief, 5. 12) Mend Inicio
LUCENA, 1 =[] 55 Mis documertos ~
Lucena, Jusn José
MANZANARES, M
Montes, Angel
RAMOS, 1 ok [ comeel | [_epy
Rarmos, Inmaculada
Zeleer, E.

5.3.Importar referencias desde Bases de Datos con Web Importer

Precisa la instalacion de la herramienta “Web Importer” en el navegador, que permitird la
importacion directa de referencias de distintas Bases de Datos o sitios web.

http:/fbibliotecas. csic.es
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Sitios que lo soportan

< ACM Portal @ ACS Publications  AHA AP AP Scitation a amazan
ﬂ ASM Eﬂ Annual Reviews A APAPsyiMET 3 anxiv E BioMedCentral
BioOne =N Cell B CiMii (@ Citeseers
Bl citeliLike 3 epsco N eLire €) Engingering vilage  [| ESA
’ Europe PMC n Frontiers -'l Gnoogle BookSearch -" Goongle Scholar |EEE ¥plare
! Infarmavarld & IngentaConnect 2 INIST I CHRS 10p Inztitute of Physics 151 Web of Knowledoe
) Jrnia o B L Lancet Joumals @ MoFl B rlasa ADS
@ Mature 05A OpticsinfoBase D ovidsP RJ Feerd PLa%
A PriAs = FuliMed @ RePEC BB RsC @ sAcE
@ ScienceDirect Sciencefag . Scopus &) SpringerLink S‘r,, S5RM
@) wHO W wikipedia Il wiley Online Library 5 wioridCat

Instalaremos la herramienta desde “Tools”>“Install Web Importer”’. Se abrird una ventana
donde se explica como instalarla, que no es mas que arrastrar el botdn a la barra visible de
favoritos o marcadores de nuestro navegador habitual.

# Mendeley Desktop
Fle Edt view [

Help

. Invice Colleagues,
L]~ | B (54

Add Files F

Uninstall 13 Ward Plugin

Mendeley

Check For Duplicates

All Documents | Edit Settings

- Literature 5e - 2 202020
Options % & &) athors a mendeley.com/i e || Q pusea

© Recently Added . Eshkar-Oren, 1.; Krief.
Wi e K lada R:
¢ Favorites . Fernandez-Garcia, MENDELEY felcome back Inmaculada Ram¢
@ My PUblications
Unsarted . GARATE, i RAMOS,
GetMendeley  Dashboard My Library ~ Papers ups  People Papers ~
Help Guid tact support Feedback & support
How it works
@ 1. Drag the "Save To Mendeley" button onto your
ES Bookmarks Toolbar. O O O Frwo-photon laser scanr

Una vez instalada la herramienta, se pueden importar directamente los resultados de una
busqueda a nuestra cuenta de Mendeley con sélo ir a una de las bases de datos que soporta
“Web Importer”, buscar, seleccionar y pinchar en “Save to Mendeley” .

€a —— o[ e + A nE 4 =-0 Sg-

cience Magazine (2] Més viskados . Gestidn de PAPL - Mad... @) Comenzar  usar Firef... (5] Ulimas noticias [ Red de Bibliotecas v A... &7 Personalizar vinculo:

ave to Mendeley

LaWeb Imagenes Mas...

Go tS[L’ cadmium - “

B 10 articles found =

Download PDFs favailable

. Cadmium in the Environment.
Académico Aproximadamente 1.280.000 resultados (0,04 5) by g i
| Hjellstrim, T (1574) 1
I Articulos Sugerencia: Buscar solo resultados en espaiiol. Puedes especificar el idioma de bdsgueda en Configuracion de Google Académico.. Cadmium +
. diana, DC (2001
Mi bibligteca wero] Cadmium in the Enviranment. viane, G (2001)
L Friberg, M Piscatar, GF Mardberg, T Kjellstrim - 1974 - cabdirect. ary . S
. 8] Light-emitting diodes made from |
Abstract In thiz second edition the authors evaluate again all the information contained in the & I BT R =i
Cualquier momento 1St and, in addition, subsequent reports and research up to and including par of 1573, Itis and a Semicomhmm‘g |)o|ym‘e|
Desdes 2015 the mast t reviews and bibl hical list in existence of the toxicological ... ey ——
soe Citado por 2040 Aticulos relacionados  Las 3 versiones  Citar  Guardar  Més (aad) o '
Desde 2014 e =
Desde 2011 [uiero] Cadmium
Intervalo DC Adriano - 2001 - Springer ) [ Fluorescence intermittency in | 4.
especifico Abstract Cadmium is a soft, ductile, siverwhite, lustrous, electropositive metal with an atam single cadmlum selenide
wt. of 112.4, density of 8.64 g cm— 3, and melting pt. of 321 °C. It has eight stable isotopes nanocrystals
with the following percentages of abundance: 108 Cd (1. 22%), 108 Cd (0.88%), 110 Cd (. Nirml, M. Dabbousi, B0; Bavventl, MG
Ordenar por Gitada por 4777 Articulos relacionados  Las 10 versiones  Citar  Guardar  Més (1998)
relevancia ) Nature
Ordenar por fecha  [PDFI LigNt-emitting diodes made from cadmium selenide nanocrystals and & semiconducting [PDF] de rice.edu
polyrmer || Preparation, clathratior =
WL Cavin, MC Schlamp, AP Alivisatos - Nature, 1994 - nananet rice.edu and catalysis of a
Buscaren la¥eb  Ejocirgluminescent devices have been develaped recently that are based on new materials two-dimensional square network
Buscar sdlo such as porous silicont and semiconducting polymers2, 3. By taking advantage of material composed of cadmium
paginas en F in the pref and of direct-gap {ll) and 4, 4"bipyridine
espafiol Citada por 3286 Articulos relacionados  Las 10 versiones  Citar  Guardar Mas Fuita, M; Kwon, ¥J (1934)

dournal of the Amevican
Fluarescence intermittency in single cadmium selenide nanocrystals
~ incluir patentes hd Mirmal RO Nahhnnsi WG Rawendi L dacklin - Mature 1897 - natire com
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En los casos de ScienceDirect y Scopus, una vez utilizado por primera vez el “Save to

Mendeley” con nuestra cuenta, aparecerd el boton de exportacion directa de Mendeley:
mSaveto Mendeley v!

ADVERTISEMENT

ELSEVIER

Elsevier’s [llustration Services
Webshop ‘ Scwemwﬁc technical & medical images, charts,

d graphs created by top Elsevier illustrators

ScienceDirect drs s

[iacmum I I | ST 0 | . RS

Search results: 166,555 results found. See image resulls
Refine filters .
& & Purchaze | ! Download POFs E> Export +
Year ia i
Chapter 13- Remediating Cadmium-C you have selected 3 citations for export.
Oz016 (14 Soil Remediation and Fiants, 2015, Pages 3¢
2016 (8,072) Muharmad Zia-u-Renman, MURSmmas S piract axport
02014 @352) b mbstract | T Purchase PDF FETTREI
2013 (8.268) as Save to Mendeley
Oz .as7) W1 Cadrmium may imasir prostats furction 4y Save to RefWorks |
e[S e el o Bpi-s
+h e 4 ] | Exportiile

casy .. B personalear viaos | Save to Mendsley @® RIS (for EndMote, Reference Manager, ProCite)

O einTex
EMENT x O Text
srvices

mages, charts,

m,n',e,fuw Save all
wief llustrators

Chapter 13 - Remediating +
Shopping cart 8 Cadmium-Contaminated Soils by
Y Growing Grain Crops Using
BN ssvincoasour Inorganic Amendments
ssem,

W savesd

8 Cadmium may impait prostate 7

+ Relevance ¥ | ¥ Al function as measured by prostate

salfullah, Hamaag Raza Ahmed, Muhammad Nadeem

5.4.Importar referenuas desde Bases de Datos incompatibles con Web Importer

Para Bases de datos no soportadas por “Web Importer”, que no permiten, por tanto, la
exportacion directa a Mendeley, importaremos en un formato compatible con Mendeley,
formatos RIS o BibTex, ofrecidos por casi todas las bases de datos, aunque con diferentes
procedimientos.

Importacion en formato RIS: Bases de datos alojadas en Proquest. Exportamos las referencias
marcandolas y pinchando en “Exportar/Guardar’>"RIS”. A continuacién, desde la versién

escritorio ir a “File”>"Import” y seleccionar el archivo RIS. También podemos arrastrar el
archivo y soltarlo.

Pl()(luesl [cadmium Y]

[ Texto completo [ Evaluado por expertos @ Modificar bisqueda | Conssjos

Basgquedas relacionadas Ocultar Con tacnologia de Proquest® smart search
Cadmiurn = Cadmium AND Heavy metals = Cadmium AND Zing = Cadmium AND Lead = Cadmium AHD Metals
Cadmium AND Copper = Cadmium AND Nickel = Cadmium AND Mercury

114250 Resultadas * | 4479 libros electrénicos de sbrary

Buscar en los resultados | Buscar figuras v tablas relacionadas Crear alerta CrearRSS [L]] Guardar blsqueda

.
» | Guardar en Area personal Enviar Imprimir Citar I Exportar/Guardar
——

2 entradas seleccionadas [Borrar]

EasyBib
[ Seleccionar 120 Wista breve | Vista detallada

EndMote, Citavi o Reference Manager
Determination of Heawy Metals in Fish and vegetables in Bangladesh and [Buista HTHL
Health Implications coF

Islam, Md Saiful; Ahrmed, Md Kawser; Habibullah-Al-Mamun, Md. Human and Ecelogical Risk

Emmmw

Rafiiqrks

ddPles... o o
dd Foler, QrleShit
watch Folder sy

A Bty Marmsaly..

[ ey
Enchiote i - Endbcte v, 1 o X5 ("mi)

e
o B EehbarOumn, L Kiif, 5. . Vascde patternig regdates iterdl
- mechanian,
Farnandss-Garcis, Jesus  Mendaley. G de Liiaacin

Syrebeceize Ubrary " o AR A RANOS M. CALMLRTACE MO DISTRINTIO

o Raes, Ivacalsds; Este c.m-.-.u».-\ammom
) = Uactuca 5. <o+ ok

[ Merseley Project - Span
Creste Growp, . Guka i Rferencia Ragiss - Céms utd
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Importacion en formato BibTex: Base de Datos Web of Science. Exportamos las referencias
marcandolas y pinchando en “Guardar en/Guardar en otros formatos de archivo”>"BibTex" y
“enviar’. Después, “Abrir con Mendeley Desktop” y “Aceptar’. A continuacidn, desde la
versidn escritorio ir a “File”>"Import”’ y seleccionar el archivo BibTex. También podemos
arrastrar el archivo y soltarlo.

InCites™ | Journal Citation Reports® | Essential Science Indicators ¥ | Endote ™ Iniciar sesion Ayuda | Espaiiol ¢

:)': =) |E :E‘ i THOMSON REUTERS™

Buscar Mis herramientas Historial de biisqueda Lista de registros marcados

Resultados: 101.993 Ordenar por. | Fecha de publicacion - de mas reciente a mas antigua ~ 4 Pagina |1 de 10000 B
(de Coleceidn principal de Web of
Science)

Busco: Tema: (cadmium) ...Mas

A [ Seleccionar pagina F = Guardar en otros for... ~ | | Agregar a la lista de registros marcados
AVISO: su organizacion no recibe

artualizaciones e datos para Guardar en EndMate online = Analizar resultados
alolinaslbaseslieloamsiisleste Guardar en EndMote desktop La funcién Informe de citas no se encuentra disponible. [7]
producta. Més informacien ’
o Guardar en R D - Escribi estas B
1. Characterization and Photocat \d cdo/cds Veces citado: 0
s Nanoparticles in Mesoporous | Guardar en FECYT CVN (en la Coleccidn principal
Crearalerta Por. Pouretedal, Hamid Reza; Basat Guardar en InCites de Web of Seience)

IRANIAN JOURNAL OF CHEM\STR EDITION Volumen: 34

Refinar resultado Enviar a archivo

2 registros seleccionados

Abriendo savedrecs. bib a wipal

Contenido del registio: [Futar, T, Fusnte, Absiract v

| Ha elegido abri:
Formato de archive [Otro software de referencia b ;] savedrecs.bib
otr sre de referencia 1
Que es: bib File

de: https:/fets. webofknowledge.com
Qué deberia hacer Firefox con este archivo?

ado por tabulador (Win, UTF-B)
ado por tabulador (Mac, UTF-8) @ Al con [ Mendeley Desktop =

A Comparison of Toxicity Mechanisms of Cigarette Smoke on Isolated Mitochondria © Guardar archivo
Rat Liver and Skin

For
Formata delimit,

[ Hacer esto autométicamente para estos archivos a partir de ahora,

5.5.Importar referencias desde el catdlogo de Mendeley (incluyendo las herramientas
“Related” y “Mendeley Suggest”)

Mendeley constituye un gran catdlogo que recoge las referencias de los millones de usuarios
registrados en él. De esta forma, es posible afadir referencias desde cuentas de otros usuarios
de Mendeley. Esta importacion de referencias podemos hacerla desde el escritorio o desde la
web de Mendeley.

Desde la version escritorio pincharemos en “Literature Search” y utilizaremos el buscador que
aparece. A continuacion, seleccionamos los documentos pinchando en el punto de la izquierda
de cada titulo o arrastramos la referencia seleccionada directamente a una de las carpetas de
nuestra biblioteca o a “All Documents”.

% Mendeley Deskiop

Fle Edt view Tooks Help

3|~ [ Ex = @ - o
Add Files Folders Relsted  Share Sync

~
Mendele —| / Literature Search
- Literature Search

{ Q0 cadmium plarts|

My Library
&1 all Documerts [ Search Results
- Recently hded v & PIuBr:n;?/Tnjl;Istysmg.!ﬁ:;; ML To... - 2005 - Braziian Journal of Plark Physiology
A Favorites _ Response to cadmiumin higher plants
2 my publicatiors L. Sanita Di Toppi; R Gabbriell - 1999 - Environmental and Experimental Bokany
Unsorted - Studies on cadmium tosicity in plants: & review

P Das; 5 Samantaray; GR Rout - 1997 - Environmental Polltion
Create Folder...

,  Cadmiumin Solls and Plants
1.1 Barrow - 2000 - Geaderma
Groups Regulatory networks of cadmium stress in plants.
| Mendeley Project - Spain Giovanni DalCarso; 5 Farinati; & Furini - 2010 - Plant signaling & behavior
Create Group... o Cadmium toxicity and tolerance in vascular plants

™M, N, Prasad - 1995 - Enviranmental and Experimental Botany
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Desde Mendeley web, iremos a la pestaina “Papers” y haremos una busqueda desde el cajetin
de busqueda simple, utilizaremos la busqueda avanzada o navegaremos por los indices de
materias. Una vez obtengamos la lista de documentos, afladiremos a nuestra biblioteca,
aquellos que nos sean de interés, pinchado en “Save reference to Library” o “Save pdf to
Library” (cuando la referencia disponga del pdf del documento). Podremos también refinar por
aquellos documentos Open Access.

Welcome back Inmaculada Ramos ? & LA Install Mendeley Desktop

Wete hiring! / Support

A MENDELEY

GetMendeley = Dashboard = My Library I papml Groups ~ People cadmium plants Q

Papers

0 [ ———
-
@
=
§ Results 1 - 20 07505,984 Preva 1 2 3 25300 » Next Refingse
a
= [] Onen Recess articles only 3
o Cadmium toxicity in plants 3
Marfa P Benavides, Susana M. Gallego, Mara L Tomaro in Brazitien Journal of Plant Physiology
(2003)

summarizes present knowiese inthe field of higher plant responses to cadmium, an
important enwironmental pollutant. Knowledge concerming metal toxdcty, including mecharisms of
-

B save PDF to lbrary J) Related research A0 readers

Response to cadmium in higher plants
L. Sanita Di Toppi, R. Gabhbrielliin Environmental and Experimental Botany (1933)

" gy 5ot knowlselgs in the fiskt of higher plant responsss to cadmium
[+ Save reference to ibrary ) Related research 133 readers

De la misma forma, se podrdn importar referencias desde la herramienta “Related”. También
se puede importar a través de la herramienta Mendeley Suggest, que da acceso a
recomendaciones de articulos a partir de nuestra Biblioteca. Para que funcione y podamos
verla en Mendeley Desktop (versidn escritorio) es preciso activarla desde Mendeley web. En la
pestafia “Dashboard” y en el apartado “Mendeley Suggest’ pinchar en “Open in Mendeley”.
Comprobar en Mendeley Desktop que la herramienta esta activada:

XA, MENDELEY

Get Mendeley | | Dashboard | MyLibrary Papers Groups People Papers v Search.

Newsfeed m Profil updstes | Groups " Install the

Ask a question ar comment here
k a question ar comment her Mendeley Suggest
advanced filter for
uiltyet It suggests
four ibrary and what

are reading.

Mendeley Suggest is the
academic iterature we,
new papers based
similar resear

Open in Mendeley

Una vez activada, para importar referencias, Unicamente pinchar en “Mendeley Suggest’ y
aceptar los documentos que queramos incluir en nuestra Biblioteca.

#A Mendeley Desktop

File Edit Yiew Tools Help

1= LG = ol
Add Files Folders Share
~
Mendeley | ] Mendeley suggest
- Literature Search
My Library

=] All Documents
© Recently Added
I Favorites

0 my Publications

Discover papers with

(" Unsorted
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5.6.Importar desde otros Gestores de Referencia

Si se dispone de bibliotecas de referencias en otros gestores, podemos anadirlas a Mendeley,
siguiendo las instrucciones que el propio programa proporciona en la pantalla de bienvenida o,
si esta ya ha sido cerrada, volviendo a abrirla pinchando desde el escritorio en “Help”>"Show
de Welcome Screen”. Pinchando en cada uno de los botones, se podran importar referencias
de los correspondientes gestores bibliograficos. Desde “Other” se importaran referencias
desde XML, BibTeX, o formato RIS.

# Mendeley Deskiop
Fle Edt Vew Tooks |y

Help Guides

Search

———————————— Mendeley Website
Mendeley Support
© Welcome toendelel  REMest Features or Bug Fixes

Check for Updates
/- Literature Search |
Create Backup...
Sy eney S Add papers to get started

= All Documents
(& Recently Added

7 Favorites

Reset Mendeley Desktop

‘About Mendeley Desktop

2wy publications

() Unsorted
Create Folder...
Groups
& Mendeley Project - Spain or import from
Create Group... @
Endnote Zotero ‘ Refworks ‘ Other.
Filter by Authors v
Al
Tools & tips
Read our Getting Started Guides to get up and running with
[ o) Mendeley. Learn how to add and organize your documents,
LEAS read and annotate your papers, and cite research as you write.
Getting
Started Getting started with Mendeley
5.6.1. Importar desde Endnote
. Mendeley Desktop [BEE
File Edit View Tools Help
Loy |ubndt | Es 2 O seacch
Add Files Folders. Share. Search
Mendeley

@ welcome to Mendeley
- Literature Search

My Library Import library from Endnote
=) All Documents
(& Recently Added

¢ Favorites
2. My Publications Open EndNote and dick File > Export..
(7 Unsorted
Create Folder... . Set your export options
Type in a file name and set the following options:
i Save il XML
o Savefile as type:
I8 Mendeley Project - Spain « Output style: Show All Fields
Create Group... « Un-checkExport selected references
Filter by Authors Click Save

All

[mport the file into Mendeley Desktop

[mport Endnote XML file...

Note;
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5.6.2. Importar desde Refworks

27 Mendeley Desktop
File Edt View Tools Help

L3> L& | E= ad
Add Files Folders Share Search
Mendeley

@ welcome to Mendeley

- Literature Search
My Library Import library from Refworks

= All Documents
(5 Recently Added

¢ Favorites
9. wy Publications .
S 5 . Log in to your Refworks account
- Jeore Select the References menu in the top left and click Export
Create Folder...
Groups . Set your export options
14 Mendeley Project - Spain * References to Include: All References
Create Group... « Export Format: Bibliographic Software
ke by auth Click Export and download the file, or email it to yourself.
er by Authors

= [mport the file into Mendeley Desktop

[mport Refworks file...

5.6.3. Importar desde Zotero

% Mendeley Desktop

File Edit View Tools Help

.7 | E& | o 2 Q-s
Add Files Folders share Search
Mendeley

@ welcome to Mendeley
# Literature Search

My Library
] All Documents.
(& Recently Added
1 Favorites
2. my Publcations

Import library from Zotero

() Unsorted
Create Folder...
Groups 1. Zotero sync
| Mendeley Project - Spain Mendeley is able to continuously import from your Zotero Library.
RS Any changes you make in Zotero will be reflected in Mendeley Desktop.
|Fiter by Authors
Al Enable Zotero Sync

5.7.Exportar referencias a otros gestores bibliograficos

Mendeley permite crear ficheros de referencias para exportarlos a otros gestores
bibliograficos. Seleccionamos las referencias a exportar y pinchamos en “File”>"Export”.
Después se podra guardar el archivo en los formatos mds cominmente usados (.xml, .ris y
BibTex).

Mendeley Deskiop
Edt View Tooks Help

Add Files... ko ==
Add Folder... Calshifero | = xport Selected Documents ? X
whatch Foldsr. . Sync —
Add Entry Manualy... Guardar o [ ] Mis documenios =l o@ e @

All Documents D See
Import... . (B mses

o B Auhors The Voar| Pt DoGumenos  (1as achivos de oroen do dotos
Send by E-tal.. e . - ecientes | o145 archivos reckidos
Herge Documents SHEEEE . e & [3 s imdgenes
e ! s videos
Delete Documents Escrlono\ymy e Files
Remave from Folder
Rename Document Fies.
Mis documentos
Synchronize Library Fs
Sign Ot (inmawramos@bib csic.5)
MiPC

Mis sibos de red  Nombre: My Collectior]
Tiox [BibTex " bib)

Ll L]

Guardar
__Comeeta |
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6. Sincronizar

Cuando importamos referencias a nuestra cuenta web en Mendeley, podemos utilizar la
herramienta de Sincronizacion para afiadirlas a la version local. Para sincronizar pinchamos en
el botén “Sync” o “File”>"Synchronize Library”’. Seleccionamos “All Documents” en el panel
“My Library”, pinchar en “Edit Settings” y clicamos las colecciones a sincronizar. A
continuacién sincronizamos (si no tenemos abierta la cuenta Web de Mendeley, nos pedira
que introduzcamos nuestras claves). La sincronizacion puede ser de Web a local y de local a
Web, de forma que también podemos enviar los pdfs guardados en el ordenador a nuestra
cuenta Web de Mendeley.

27 Mendeley Desktop
N Edt Vew Took Help
Add Files... ctrl+o =
Add Folder... alshitio 1 Q
wiatch Folder... ync Search

Add Enitry Marualy...

£ all Documents Edit Settings
Import.., »

® [ Authors Title Year Published In Added A Detais Notes Contents Envichments
° Guia de Referencia Rapida - Como utiizar Mendeley en 2013 may 11
4 pasos
. (Consejo Superior de Investigaciones Cientificas - may 14
=l Proyscto Mendsiey
. Das, P.; Samantaray, S.; .. Studies on cadmium toxicity in plants: & review 1997 Environmental  2:28pm
Pollution
. Benavides, Maria P} Galle... Cadmium toxicity in plants 2005 Brailian Journal — 2:28pm
£l of Plant Physil..
Sign Ouk (inmaramos@bib.cai.e5) o Das,PySamantaray, 5. .. Studies on cadmium tosicty in planks: A revien 1997 Environmentsl  2i28pm
Quit. Cr+Q Pollution 3
Groups * wollerwieider, Pierre; Cosi.. Localization and effects of cadmium in leaves of & 2006 Environmental  may 29
& Mendeley Project - Spain y cadmium-tolerant willaw (Salix viminalis L), Part IT Micr and Experimen
1A Bienveridos a Mendsley 2015 ° Latowski, Dariusz; Kruk, 3. Inhibition of 2eaxanthin epoxidase activity by cadmiom 2005 Journal of may 28
ions in higher planks Inorganic Bioch...
Create Grovp v o Ding VanFe; Zhu, Chena  The role of microRNAs in copper and cadrmium 2009 Bochemicaland  may 29 U
= homeastasis Biophysical Res.
Fiter by ALthar Keywords -
- Gallegn, SusanaM.; Pen.. Unraveling cadmium toxicity and tolerance in plants: 2012 Ervironmental  may 29
o ¢ Insight into requlatory mechanisms and Experimen I No documents selected
Abiotic sty
AcCMULETION — o Paikovd, aniels; Mace . Cadrium tolerance and accumulation n transgenic 2004 Internationdl  may 29
Amendments tobacco plants with a yeast metaliothionein combined Bindeterioratio.
Antheraxanthin ° Fthenakis, Yasiis M. Life cycle impact analysis of cadmium in CdTe PY 2004 Renewable and  may 29
Anticidant system production Sustainable Ene.
:““D““m . & {a, Beléng H & comparative study 2011 Plant Physiology  may 29
s THALIAA e p\ar\ts and cadmium-exposed plants und. and Biochermistry

7. Trabajar con las referencias y documentos
7.1. Crear y organizar carpetas

Podemos crear una carpeta pinchando en “Create Folder’. A continuacion, pondremos el
nombre que queramos asignarle. También, podemos crear subcarpetas, seleccionando la
carpeta donde queremos crearlas y con el botén derecho del ratén, pinchar en “New Folder”.
Asimismo, con el botén derecho del ratén podremos borrar o renombrar una carpeta.

% Mendeley Desktop

Fls Edt View Tooks Help

Add Files Foldsrs Related  Share  Sync
.
Mendeley = All Documents | Edit Settings
) Literaturs Search
* @ B Adhas Title Vear| Publshed In  Added Al perals |
My Library . An, Youn 1, Sail ecataxicity assessment using cadmium sensitive 2004 Enwironmental  may 29
s Polation
S pee mdded . Andresen, Elisa; Kipper, .. Cadmin e
I Favories o Aasimowiczlelonek, Ma.. Theme Rk E Vew Tok Heb
2. 1y Putlcations plarts =
= "
Unsorted * Baquero Arribas, Mercedes :Z :E\;aa\ I} ¥ ® (%)
MiFks s Reded e S
Grouns NIOSE T deley A% 0 0 s e Vou Pbkbefln  Adhd
& L. e  Barow i) . Usatre seuc GARATE, &;ANOS, ;M. CADMLN LPIACE ANDDISTRIBUTION N OATIVRS 1980 BULETINGE b 4
& Mendeley Projact - Spain . OFLACTUCA S EMWIRONMENT.
[ & Bienveridos a Mendeley 2015 o @) Benavides, MariaP; Gale.. Cadmiu L o ) Rows, Imoaads e, Cadvamptae andsbeekia dtbtennpkrts ol 200 Pt abr
o Lactuca p, G- keracen
Create Group... ; . 2 Do
> (g Bemdies Phiaky G, Gy o Ranos Imsadad Mo Sunivoschins e douents s et 1990 Biresondde e 10
T — == © Aoty adied Isbfemacin
;I o1 by Author Keywords . Bodar, C.W.M.; van der 5... Cadmiu [o—
[
;E‘Emﬁ[:ﬁw - > Car, John Py Murphy, Al Cadmiu |2 iy Relted Docunerts
Amendments {reated .
Antheraxanthin . Dalcorso, Giavanri; Farin.. Reguldl CedeR ‘
Groups Edt Setogg
ey i |
s e
ABeHis pgop., QN
CedeGup |
Fierby bt s v
w
G
Celnd
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7.2.Marca de Leido/No Leido y Favoritos

» Leido/No Leido: Podemos marcar o desmarcar las referencias para diferenciarlas como
leidas o no leidas, pinchando en el punto verde que aparece a la izquierda de cada
referencia.

» Favoritos: Podemos marcar como favoritos, las referencias y documentos, pinchando en el
icono de estrella, que también aparece a la izquierda de las referencias. Estas referencias
marcadas aparecen automaticamente en la carpeta “Favorites”.

% Mendeley Deskiop

Fle Edt View Toos Help

]~ | Es = @ Lag <
#cd Fles Folders Related Share  Sync
-~ =
Mendeley =) allDocuments | Edi settings
J Literature Search
I tendeley suggest * ® B auhos Ttle vear Publishedn | Adc
o o @ Benavides, Maria P Gale... Cadmium toxicty in plants 2005 Brazlian Jowrnal  jun
My Library Bl of Flart Physiol
I o Vollenveider Pierre; Cosi... Localieation and sffects of cadmium in eaves of @ 2006 Enviormertal  ma:
= cadmiumr-tolerant willaw {Salcs viminalis L ), Part IL Micra... and Experimert...
= Recenth aced g
7 Faworites -
2. My Publications * Mendoza-Cézatl, David; L
Unsorted ® Seng, Won-Yong; Sehn, E.
Creats Folder..
. Harada, E; Choi, ¥ E; Tsu
Groups

7.3. Ver y ordenar las referencias

Podemos ver las referencias o documentos de nuestra Biblioteca pinchado en “All
Documents”. Ademas, podremos visualizarlos en forma de tabla o cita, pinchando en “View” y
seleccionando “Library as Table” o “Library as Citations”, respectivamente. Asimismo, se
podran ordenar los documentos por cualquiera de las columnas de la tabla, simplemente
pinchando en la cabecera de cada columna. Asi, podran ser ordenados por: favoritos, leido/no
leido, documentos con pdf adjunto, autor, titulo, afio, revista y fecha de incorporacion a la
Biblioteca.

% Mendeley Deskiop

File  Edit B Tools  Help
Lbrary a5 Table Ordenar
3 a
Search

Add Files
S ciation Style

Mendeley  1oohar Layout

- Liter| v show Document Detals  Alt+Return
I venddiey S ” Detalls | Wotes | Contents | Enrichments
o * Aan, Youn J. ol ecotoiicty assessment using cadmium sensitive 2004 o maves
My Library plants Pallution
& e o Andresen, Eisa Kipper ... Cadmium toxichy in plants. 2015 Metalionsinlfe  may 29
ik stiences
£ Recently Added . Arasimowicz-Jelonek, Mag... The message of nitric oxide in cadmium challenged plants 2011 Plank Science may 28
1 Favorkes
2wy Publications o Bauero Arbas, Mercedes L evaluacidn dels eoleccion de s biblokecs, un bien may 1L
' necasarin en empos de crisis
Unsorted . Barroso, Juan B.; Comas... Localization of S-nitrosoglutathione and expression of 5~ 2006 Journal of may 29
Create Foden... nitrosoglutathione reductase in pea plants under cadmi Experimental Bo.
o Bamom I Cadmium in Sois and Plants 2000 Geoderma may 27
Groups
[ Hendeley Project - Spain o @ Benovides, Maria P, Galle . Cadmium tosicky in plants 2005 Braziian Jourmal  may 26
- = of Plant Physiol
Create Group... ~ > Bodar, €.W.M.; van der 5I... Cadmium resistance in Daphria magna 1990 Aquatic may 26 i
Toxicology
Fiter by My Tags ~
Cart, John F; Murphy, Ale... Cadmium blocks viral ivasion in plants. 2002 Hature cel may 28
Al . eh o Bers v No documents selected
Consefo Superior de Investigaciones Clentficas & DalCarsn, Giovanni; Farin... Regulatary networks of cadmium stress in plants. 2010 Plant signaling & may 29
. Dalcorso, Giovanni; Farin... How plants cope with cadmium: Staking al on metabolsm 2008 Journal of may 29
and gene expression Integrative Pla
o Das P Samantaray, S.; .. Studies on cadmium toxiciy in planks: A review 1997 Environmental  may 26
Pallution
N Deckert, Joanna Cadmium taxicity in plants: Ts there any analogy to ibs 2005 BioMetals may 29
carcinogenic effect in mammalian cels?
o Ding, YanFej; 2hu, Cheng  The role of microRNAs in copper and cadrium 2003 Biocherical and  may 29
homeostasis Biophysical Res
. Eshkar-Oren, L; Krief, S.... Yascular patterning requlates interdigtal cel deathby @ 2015 Development  abr 14
= RO5-mediated mechanism
. Farinati, Silvia; DalCorso, . The Brassica juncea BJCAR15, an orthalog of Arabidopsis 2010 Mew Phytologist  may 23
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7.4. Revisar las referencias

Si, tras la importacién, las referencias contienen datos erréneos o bien estdn incompletas,
podemos editarlas. Para ello, seleccionamos el documento a corregir o completar y en el panel
de detalles (columna de la derecha), afiadimos etiquetas o detalles o corregimos los datos
erroneos. También, podemos adjuntar el documento a la referencia, con la opcién “Add File".
De igual forma podemos editar un campo de varios documentos a la vez, seleccionandolos con
la tecla Ctrl a la vez que pinchamos los documentos, en el panel de detalles aparecera un
mensaje de confirmacién vy, finalmente, afiadiremos los datos a incorporar en todos los
documentos.

#* Mendeley Desktop E'E'E'

Fle Edt View Took Help

]~ | B = | | ® =7 < Q-
add Flles Folders Related  Share  Sync Searth
Al 5
Mendeley =] AllDocuments | Edi: Settings
- Lterature Search
* @ B authors Title Vear PublshedIn | Added | Woetals | Wotes | Contents | Enrichments
My Library Sandalio, L M; Dalurzo, H ... Cadmium-induced changes in the growth and oxidative 2001 Journal of may 29 ~
= b Abstract: ]
2 8l Documents metabolism of pea plants experimental b
@ Sanita Di Toppi, L.; Gabbr... Response to cadmium in higher plants 1999 Environmental  may 26
= )L
L Recently Added . i
B Favortes . Sarwar, Nadeem; Safuls... Role of mineral nutrition in minimizing cadmium 2010 Journslofthe  may 28 Tags:
2. by Publications accumulation by plants Science of Foo, Conseja Superior de Investigaciones Cientificas
rem— . Seregin, 1. v; Tvanov, Y. B. Physiological aspects of cadmium and lead toxic effects 2001 Russian Journal — may 29
— on higher plants of Plant Physiol Author Keywords:
Create Folder. . sheng, Xia Fang; Xia, Ju... Improvement of rape (Erassica napus) plant growth and 2006 Chemosphere  may 29
cadmium uptake by cadmium-resistant bacteria
Groups o Shi, Vuan-zhi; Ruan, Jian... Accumulation and distribution of arsenic and cadmium by 2008 Journal of may 29 City:
& mendeley Project - Spain teaplants, Zheijiang Univer..
Creste Group. N Song, Won-Yong; Sohn, E... Enginesring tolerance and accumulation of lead and 2003 Nature may 29
cadniumn in trarsgenic plants. bintechnology _—
Institution:
. Stowt, Lisa M.; Dodova, E... Phytoprotective influence of bacteria on orowth and 2010 Water Research  may 29 /]
cadmium accumulation in the aquatic plant Lemna minor
~
Fiker by My Tags o Stou Lisath; Nisslen, .. Shits inrhizoplane communites of aquatic plarks after 2005 Appledand  may 29 per:
al . i cadmium exposure Enwironmertal Ljl Number:
Canszjo Superiar de Investigadanes Centificas &~ “erbruggen, Nathalie; He... Molecular methanisms of metal hyperaccumulation in 2009 Mew Phytologist  may 29
plants
. Verbruggen, Nathalie; He... Mechanisms to cope with arsenic or cadmium excess in -~ 2009 Current Opinion — may 29 Series: 1
in Plant Biology
o “llenweider, Pierre; Cosi... Localization and effects of cadmium in leaves of 2 2006 Envirormental  may 29
cadmiumr-tolerank willovy (Salbx viminalis L.). Part IT Micr. and Experimen URL:
* waslkes, Michael P Cadmium carcinogenesis 2003 Mutation may 26
Research - Fun
. WILLIAMS, €, H.; DAVID... THE ACCUMULATION IN SOIL OF CADMIUM RESIDUES 1976 Soil Science may 23 Catalog IDs
FROM PHOSPHATE FERTILIZERS AND THEIR EFFECT
* Molecular plant pathology : a practical approach - C5IC may 19 ot
a A Files: —
. Guia de Referencia Rapida - Como utilzar Mendsley en 2013 may 11
4 pasos - Unknown - Consejo Superior de Investig
C may 14
A
¥ 1] 1 of 53 documents selected

Al importar referencias, si el sistema detecta que estdn incompletas, crea una carpeta llamada
“Needs Review” donde quedaran hasta que sean revisadas.

7.5.Buscar

La version local, Mendeley Desktop, permite localizar documentos rdpidamente en nuestra
Biblioteca de dos formas distintas:

» Mediante un buscador “Search” situado en la parte superior derecha, que permite buscar
aquellos documentos que contienen un determinado término, el cual aparecerad resaltado,
tanto en las referencias como en todos los documentos que lo contienen.

. Mendeley Deskiop [BEE

Fle Edt View Toos Help
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Mendeley “| 5 AllDocuments [ Edt Settings
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) Al Documents _

- Mendeley. Guia de Utilizacion " N . "
© Recently Added Jesus Fermandez-Garcia - 2015 Guia de Referencia Rapida - Cémo
. Abstract: __Utiizacién del Gestor de Referencias Mendeley, creada paralos usuarios de la Biblioteca utilizar Mendeley en 4 pasos
7 Favorites Author keywords: . de referencias sociales, Guia, Manual, Mendeley
0. my publications ) . Authars:
Guia de Referencia Rapida - Cémo utilizar Mendeley en 4 pasos
|| Unsorted - 2013

#A view research catalog entry for this paper
Create Folder,.. Consejo Superior de Investigationes Cientificas - Proyecto Mendeley

Vear: 2013
[} .
Groups * T PROVECTO DE IMPLANTACIGN DE MENDELEY INTERNATICNAL EDITION (MIE) EN EL €51C Inmaculada Pages
[ tendeley Project - Spain 1
Create Group... Abstract:
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» Mediante la utilizacion de filtros por determinados parametros: autor, palabras clave,
etiquetas, titulos de revista (desplegable etiquetado como “Filter by’ que aparece en la
parte inferior izquierda).

22 Mendeley Desktop

Fle Edt View Tools Help

FERN=" - | | @ = [+
Add Files Folders Related  Share  Sync

Al o
Mendeley ~ | Z) AllDocuments | Edit Settings

- Literature: Search
Results for "mendeley’ in “All Documents™

My Library
*| @ B SearchResults
Mendeley. Guia de Utilizacion
+ Recently Added Jesus Fernandez-Gareia - 2015
. Abstract: . blizacién del Gestar de Referencias Mendeley, creada paralos usuarios de la B
U0 Favares Author Keywords: e referentias sodiales, Guia, Marual, Mendeley
2. My Publications

=1 All Documents

Guia de Referencia Rapida - Como utilizar Mendeley en 4 pasos
[ Unsovted . 2013

Create Folder... Consejo Superior de Investigaciones Cientificas - Proyecto Mendeley

Groups ® Bl GROVECTO DE IMPLANTACICH DE MENDELEY INTERNATIONAL EDITION (MIE) ENEL CSICT
& Wendeley Project - Spain

Create Group...

Filter by Author keywords 2)

Filter by Authors
Filter by My Tags
Filter by Publications

Antioxidant system
apoplasm

7.6.Duplicados

Al importar referencias a nuestra Biblioteca en Mendeley, puede ocurrir que algunas estén
duplicadas. Para comprobar si hay duplicados, seleccionamos la carpeta a revisar y desde el
menu principal pinchamos en “Tools”>"Check for Duplicates”. De esta forma, se detectan los
documentos duplicados que son agrupados en la vista principal del panel de documentos.
Pinchando en la flecha de la izquierda de las referencias podemos ver todos los documentos
de un grupo. Una vez seleccionado un grupo de duplicados, antes de unificarlos podemos
revisar los metadatos en el panel de la derecha “Details”. Cuando a la izquierda de cada campo
aparece una marca, quiere decir, que ese campo contiene la misma informacién en todas las
referencias. Si no aparece marcado, entonces dos o mas referencias no tienen la misma
informacién, por lo que deberemos comprobar que, efectivamente, estan duplicadas. Una vez
comprobado que las referencias estdn duplicadas, unificaremos pinchando en “Confirm
Merge”.
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7.7.Anotaciones en los pdfs

Mendeley dispone de un visor de pdfs en la versién local que permite subrayar textos
pinchando en “Highlight Text” y hacer anotaciones tipo post-it, pinchando en “Add Note”.
Estas anotaciones y subrayados, cuando el pdf pertenece a un grupo, pueden compartirse con
los miembros del mismo, sincronizando con Mendeley Web (apartado 6). Para ello, deberan
hacerse abriendo el pdf dentro del grupo.
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Fle Edt View Go Tools Help
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Las notas y subrayados estan guardados en la cuenta de Mendeley, si queremos crear un
nuevo pdf con todo esto, exportaremos el pdf pinchando en “File”>"Export pdf with
Annotations”.
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8. Insertar citas y crear bibliografias

8.1. Estilos de citas bibliograficas

Mendeley dispone de un elevado nimero de estilos de citas. Para seleccionar el que queremos
utilizar, desde la versidn local, pincharemos en “View”>"Citation Style”. A continuacion,
pincharemos el elegido (por defecto, Mendeley ofrece los mas comunes y los que vayamos
utilizando). Si queremos uno que no aparece en ese listado, pincharemos en “More Styles”, lo
buscaremos y lo instalaremos.
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También podremos crear nuestro propio estilo de cita o editar uno de los existentes pinchando
en el botdn derecho del ratéon y “Edit Style”.
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8.2. Crear bibliografias e insertar citas

Para generar bibliografias e insertar citas debemos instalar el plugin para Word. Para ello,

pincharemos en la opcion “Tools” del menu principal y después “Install MS Word Plugin”.
[ Mendeley Desktop
File Edit View | Tools Help

% Invite Colleagues... z
- ]

Add ¢ Install Web Importer... Remove  Sync
Documents e 1ctall MS Word Plugin Folder  Library

ibrary

|| All Documen Options...

Una vez instalado, en la pestaia “Referencias” de nuestro Microsoft Word aparecera un
bloque de botones perteneciente a Mendeley.

> Insertar citas: Colocamos el cursor donde queramos insertar la/s cita/s. Pinchamos en
“Insert Citation”, buscamos y vamos seleccionando la/s referencia/s a citar. Finalmente,
pinchamos “OK”. Podemos cambiar el estilo de la cita con el desplegable del plugin.

I~ R R Documentol - Microsoft Word

Inidio  Insertar  Disefio de pigina | Referencias | Correspondencia  Revisar  Vista

[+ Agregar texto ~ [atnsertarnotaal final | =8 style: Plant and Soil E & Administrar fuentes 'j 59 Insertar Tabla de ilustraciones j 2 Insertar in
(2 Actualizar tabla A Siguiente nota al pie] = CQnsert Bibliography (2 Estilo: APA, 5%ed -
Tabla de Insertar . Insert lnsertar Insertar Marcar
contenido = notaal pie agnola Citation [2] Refresh E cita~ @ Bibliografia * titulo ﬂRETE'E”m eruzada entrada
Tabla de contenido Hotas al pie blegdeler Cite_ 0L otic Citas y bibliografia Titulos ndice

Insertar citas(Benavides etal. 2005)

J
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Cadmium toxicity in plants

Mariz F. Benavides; 5M Gallege; ML To... - 2005 - Braziian Journal of Flant Physiology
Abstract ..of higher plant responses to cadmium, an impertant environm
Author Feywords: Cadmium, Heavy metals, Metal toxidty, Oxidative stre:
Accumulation and

etaboli fl
David Mendoza-Cézatl; HLaza-Tav: - 2005 - FEMS Micrabicloay Reviey

My Library | @sn To vendeley | ok |

insertarcitas{shi etal. 2008)(Song etal. 2003)

> Crear Bibliografias: Para incluir el listado de la bibliografia utilizada en nuestro trabajo, es
decir, generar la bibliografia, pincharemos en “Insert Bibliography”.

Wid9-vis Documentol - Microsoft Word
Tnido  Insertar Disefio de pagina Referencias Correspondencia Revisar  Vista
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Tabla Insertar Insert Export [HSEREV Insertar Mar
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Tabla de contenido Notas al pie 5 Mendeley Cite-O-Matic Citas y bibliografia Titulos

Insertar citas{Shi etal. 2008){Song etal. 2003}

ShiY, Ruan J, MaL, etal (2008) Accumulation and distribution of arsenic and cadmium by tea
plants.J Zhejiang Univ Sci B 9:265-270. doi: 10.1631/jzus.B0710631

SongW-¥, Sohn EJ, Martinoia E, et al {2003) Engineering tolerance and accumulation of lead
and cadmium in transgenic plants. Nat Biotechnol 21:914-919. doi: 10.1038/nbt850
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Nota: Si hacemos cambios en las citas, el programa hace los cambios cuando los detecta.
Podemos forzar el cambio pinchando “Refresh”.

9. Organizador de referencias o documentos

Mendeley permite organizar o gestionar de forma automatica nuestros documentos,
renombrando nuestros pdfs y alojandolos en una carpeta o subcarpeta, segin una estructura
de carpetas, previamente establecida, basada en detalles de los documentos. Podremos
configurarlo desde “Tools”>" Options”>"File Organizer”

tendeley Desktop NEE
Ol (el el @] (2] & Q-
Ak Flles Folders Related  Share  Sync Search
=T 2 Options 3]
My Library =) & anpo
=]l All Dacumerts General | Document Detals | FileOrganizer | watched Folders | BibTex | zotera | comnection -
= * o O frais | motes | contents | Errichments
2
© Recently Added . ] Orgorize my Fies
1 Favorites
@ My Publications . Copy Files tor [ C:\DocLments and s ol Deskiop Browse... Ticy Up
£ Unsorted Open folder in Windows Explorer
Creats Foldet... .
Sort Fies nto subfolders
Groups . ‘
Unused felds: | (vear) (Title
[ Mendeley - Evaluacién del Nivel 2 (4) .
& Mendeley Project - Spain Drag bubbles down to add or up to remove.
| Bienvenidos & Mendeley 2015 .
Create Group... o N Folder path:  |(Author ) (Journal ‘
> Evampler C:\Documents and s o Journali
Filter by My Tags v
. Rename document files
Al . No documents selected
mr;s‘ezm Superior de Investigaciones Cientficas . Unused Fields: | ool ‘
. Drag bubbies down to add or up to remove. Hyphen-separated
- File name: Author fear Title ‘
b Example: Author - Year - Title.pdf
.
Ok Cancel Appl
. I J [eemy ]
- Das, P.; Samantaray, .1 Studies on cadmium toxicity in plants: & review 1997 Erwironmental un3 ‘ ‘

“Organize my files” hace copia en una carpeta de todos los documentos en nuestra Biblioteca,
“Sort files into subfolders” crea una estructura de carpetas segln detalles de los documentos y
“Rename document files” renombra los documentos incluyendo, autor, revista, titulo y afo.

10. Grupos de trabajo

Mediante los grupos de trabajo, Mendeley permite compartir referencias y documentos con
otros investigadores.

> Buscar grupos de trabajo publicos

Podemos buscar grupos de trabajo publicos, que trabajen en nuestra area de interés, desde la
pestafia “Groups” en Mendeley web, haciendo una busqueda directamente o a través de los
listados de disciplinas.

M EN _EL_E Weleome back Inmaculada Ramos TR Install Mendeley Desktop
We'te hiring! | Support

GetMendeley = Dashboard = MyLibrary  Papers People Groups = Search Q

Groups

Inthis catalog: 106,690 public sroups Create a new group
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» Unirse o seguir a un grupo de trabajo publico

Podemos seguir a un grupo de trabajo publico, cuya area de investigacion nos interese,
pinchando en “Follow this group” o intentar unirnos al grupo pinchando en “Join this goup”, si
es publico abierto o en “Ask join this group”, si es publico con invitacion.

>

Welcome back Inmaculada Ramos f [TELSIIERAN install Mendeley Desktop
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A MENDELEY
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Seabirds - heavy metals and isotopes

Inthis grougps 49 papers - 16 members
5 Jointhis group i }» Share @3

Mendeley Biclogical Sciences [+ Groups 1 Follow this group
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19th October, 2012
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18th August, 2012

> Crear grupos de trabajo

Desde la version escritorio, podemos crear un grupo de trabajo pinchando en “Create Group”,
en la columna izquierda de la pantalla o desde la opcién “Edit’>"New Group” del menu
principal.

2 Mendeley Deskiop
Fie W@ View Tooks Help

O =)
Add e Sync
Find Chr+F -
Cut Cirk+ = &
Copy ame bl Create a new group
Paste Chrl+ty
Select Al Clrkea
Mew Folder. Ctr4-Shift+h
Ctrl+Shift+M
Rename Folder. .. Fz
Groups
& Mendeley - Evaluacion del Nivel 2 (4)
[ Mendeley Project - Spain L @® @Private
K ndeley 2015
Create Group
v

A continuacidén, se nos solicitaran los detalles del mismo: nombre del grupo, breve descripcién
y tipo de grupo. Los grupos podran ser:

e Privados: Se puede pertenecer a ellos sélo por invitacion. Su contenido sera visible
Unicamente para los miembros del grupo. Son grupos para proyectos de investigacion
privados o para compartir documentos y anotaciones.

e Plblicos con invitacion: Visibles para todos, pero en ellos sélo pueden contribuir los
miembros del grupo. Utiles para listas de lectura publica o para conservar los
resultados de investigacion.
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e Pulblicos abiertos: Cualquiera puede unirse y contribuir en ellos. Grupos para discutir
sobre un tema.

Una vez creado, o si somos miembros de un grupo, pinchado en el nombre veremos varias
pestafias: “Overview”, “Documents” y “Members” .

# Mendeley Desklop [BE]
Fle Edt View Tools Help
Al | & | B @ B [s] Q-

Acd Files Folders Related  Share  Sync Search

T AlDacumerts -

r Mendeley Project - Spain, owned by Massimiiano Bearzot Edit Settings
) Recently Added L ¥ Project - 5p 4 z
I Favorites Overview | Documents | Members !

@ My Publications &
Unsorted sk a question or commen: here
Create Folder... About this group

“Overview”: Desde ahi estaremos informados de lo que estd ocurriendo en el grupo: quién se
une, quién comenta y qué documentos han sido afiadidos y por quién.

“Documents”: Podremos ver los documentos del grupo, ademas de afiadir nuevos (pinchando
en “Add Documents” en la barra de herramientas o “arrastrando y soltando” desde nuestras
carpetas en Mendeley o desde cualquier lugar de nuestro ordenador).

“Members”: Veremos los miembros que componen el grupo y podremos anadir a otros que ya
sean contactos nuestros en Mendeley pinchando en “Add” o invitar por e-mail a otros a unirse
al grupo, pinchando en “Invite”.

Todos los detalles dados al grupo los podremos cambiar en “Edit Settings”. También,
podremos eliminarlo desde “Edit”>"Remove Group”.

» Anotaciones en grupos

Los resaltados y las anotaciones hechas en pdfs de documentos se comparten en los grupos,
siempre que se realicen abriendo el documento desde el grupo, no asi las realizadas abriendo
el documento desde el espacio personal, y sélo en los grupos privados.

11. Version Web

En la versién web podemos completar nuestro perfil en “My Account”’, ademas de, conocer

actualizaciones de nuestros contactos, gestionar nuestra Biblioteca, buscar documentos y
contactos y crear grupos, desde una serie de pestafias.

Wielcome back Inmaculada Ramos % LULCHLIISRg | Install Mendeley Desktop

SR, MENDELEY ‘ _

Account details

Get Mendeley IDashhoaTd MyLibrary | Papers = Groups Paoplel Papers v odf Privaey Q
i

Motifications

Billn
Newsfeed a Profile updetes | Groups N b Importer
Logout r lats you impart
Ask a question or comment here ocuments from

C databases. You
can i 110 waur browser here

» En “My Account” odemos actualizar nuestro perfil: datos personales, experiencia
laboral, intereses profesionales, formacién, etc (“Edit my profile”). También podemos
configurar nuestra cuenta en temas de privacidad, notificaciones, etc en “Account
Details”.
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» Desde el panel de pestafias:
— Dashboard: Podremos conocer las actualizaciones de nuestros contactos.
— My Library: Accederemos y gestionaremos las referencias bibliograficas de nuestra
Biblioteca. Al igual que desde la versidn escritorio, podremos:

1. Afadir documentos, manualmente, desde nuestro ordenador de forma
individual o podremos anadir una carpeta completa con todos los pdfs
contenidos en ella, pinchando en + Add.

Completar los detalles de un documento pinchado en “Edit”.
Borrar documentos pinchando en “Delete”.

Organizar las referencias pinchando en “Organize”.

Crear carpetas en “Create Folder” .

Crear grupos en “Create Group”.
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— Papers: Podremos hacer busquedas en todo el catdlogo de Mendeley, desde el
cajetin de busqueda simple o bien, utilizando la busqueda avanzada. También
podremos navegar por los indices de materias.

— Groups: Desde esta pestafia podremos crear grupos, pinchando en “Create a new
group”. Acceder a los grupos a los que pertenezcamos. Buscar grupos en
Mendeley y ver las referencias y miembros que los forman, pudiendo unirnos “Join
this group” o seguirlos “Follow this group”.

— People: Desde aqui podremos localizar a investigadores a los que poder seguir
“Follow” o con los que poder contactar “Send message”.

http:/fbibliotecas. csic.es
Pagina 24 de 24



